
In this chapter

• Learn to create forms

• Use forms to view and edit data

• Find the data you need in form view

8

Creating and Using

Data Entry Forms

Your database performs many tasks, and storing data is just one of

them. After you have tables, you need a way to enter and modify data.

The most efficient way to work with your data is through forms. Forms

let you determine what data is displayed and what types of changes you

can make to it.

A properly designed form will help you enter data more quickly and

accurately. If you’re creating an Access application to replace a process

that currently uses paper forms, you can design your Access forms to

look just like the paper forms. This will help ease the transition from

paper to computer. You can also apply rules that limit the type of data

the form accepts, which protects the data from some typos and other

human errors.
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At this point in your adventure, you have a few tables
and queries, and now you’re ready to advance to
forms. In the next section, you’ll create a couple of
data entry forms for your gardening database
using a few of the wizards that come with Access.

Creating Simple Forms
As with many other things in Access, there is more
than one way to create a form. You can choose
from the following three ways:

■ You can use an AutoForm wizard, which
automatically creates a form displaying all
the data in a table or query.

■ You can use the Form wizard, which auto-
matically creates a form after you specify
which fields you want the form to display
(and a few formatting choices).

■ You can create a form from scratch in design view.

The Wizard Way
Without a doubt, the quickest and easiest way to create a form is to let Access do the
work for you—use a wizard whenever you can. The two types of form wizards are as
follows:

■ AutoForm Wizard—Creates a specific type of form and displays all the
data in a table or query, without asking you any questions.

■ Form Wizard—Lets you choose the type of form it produces and which data
the form displays.

The AutoForm Wizard
Five AutoForm wizards are available, and each one automatically creates a specific
type of form:

■ Columnar—Stacks the fields, one on top of the other, beginning with the
first field in the table or query until all the fields are lined up in a single col-
umn.

■ Tabular—Aligns the fields beside each other in a row, positioning the first
field in the table or query at the far left and adding subsequent fields in the
same order they appear in the table or query.
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You can download the
Chapter 8.mdb sample file,

which is inclusive of all the exam-
ples in this chapter, from http://
www.quepublishing.com/. If you
want to follow along with our
examples, download Chapter
7.mdb.
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■ Datasheet—Displays all the fields in the table
or query in the familiar table (or datasheet)
row and column format. The form will look
just like a table.

■ PivotTable—The wizard opens the form in
PivotTable view. (We won’t review this wiz-
ard in this book.)

■ PivotChart—The wizard opens the form in
PivotChart view. (We won’t review this wiz-
ard in this book.)

To quickly create a data entry form based on the
Plants table, follow these steps:

1. Click the Tables shortcut in the Object bar,
and then select the Plants table in the
Database window.

2. Select Form from the Insert menu. Or, click the drop-down arrow next to the
New Object button on the main Access toolbar and select Form from the list
that appears.

3. In the resulting New Form dialog box, select the AutoForm: Columnar
item, as shown in Figure 8.1, and click OK. Or, you can simply double-click
the wizard. If you didn’t choose the table beforehand, you can do so now by
selecting a table or query from the drop-down control at the bottom of the
dialog box.
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The PivotTable and
PivotChart forms are for

advanced analysis of large
amounts of data. You won’t need
to use them in this book.

FIGURE 8.1

Select the

AutoForm:

Columnar

Wizard from 

the New Form

dialog box.

4. Save the resulting form, shown in Figure 8.2, by clicking the Save button on
the Form view toolbar. Then, enter the name Plants in the Save As dialog box
and click OK.
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Figures 8.3 and 8.4 show two more forms. Specifically,
we used the AutoForm: Tabular Wizard to base a
form on the Catalogs table and the AutoForm:
Datasheet Wizard to base a form on the Types table.
Creating these forms will help you practice with the
AutoForm feature and show you the variety of forms
you can get with a minimal amount of effort.
Sometimes, though, you’ll find that AutoForms just
aren’t good enough for what you want to do with the
database. We’ll show you how to create more com-
plex and customized forms in the rest of the chapter.
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FIGURE 8.2

A columnar

form stacks the

controls verti-

cally.

Inherited lookup field

In Chapter 6, “Tapping
the Power of Relationships,”

you added a lookup field to the
TypeID field in the Plants table. We
told you then that a form will
inherit a lookup field, and that’s just
what happened with the Plants
form. The TypeID control in the
form shown in Figure 8.2 is a
combo box control—you can tell by
the drop-down arrow to the right
of the control. You’ll learn more
about combo box controls in
Chapter 13, “Customizing Forms.”

FIGURE 8.3

The tabular

form aligns the

controls in the

same row.

FIGURE 8.4

Datasheet forms

look just like a

table (or

datasheet).
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About Subforms
You might have noticed that the New Object button’s list includes an AutoForm
item, but you didn’t select it in the previous example. This wizard automatically pro-
duces a columnar form similar to the AutoForm: Columnar Wizard used earlier. But
there’s an important difference between these two wizards: The wizard in the New
Object list includes a table’s relationships in the finished form. As you’ll see, the rela-
tionship between tables translates into a relationship between forms. Specifically, the
resulting form has a subform (an embedded form within the main form) that dis-
plays related data.

We’ll show the difference between these two forms in the following steps. Let’s use
the AutoForm Wizard on the New Object list to base a form on the Catalogs table.
To do so, follow these steps:

1. Click the Tables shortcut in the Object bar, and then Select Catalogs in the
Database window.

2. Open the New Object button’s drop-down list and select AutoForm. Figure
8.5 shows the new form. Note that the wizard uses the name of the main
table (Catalogs) as the title of the form, even though the form shows data
from both the Catalogs table and the Plants table. Save this form as
CatalogsAndPlants.
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FIGURE 8.5

The AutoForm

Wizard accom-

modates the

relationship

between the

Catalogs and

Plants tables.

The related subform

The main form

This form is special because it includes data from both the Catalogs and the Plants
tables, even though you didn’t tell the wizard to do so. That’s because the wizard
encountered the relationship between the two tables and included a subform to dis-
play the related plant information for the current catalog.
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The main form displays the catalog records, and the
subform displays plants where the primary/foreign
key value in the two tables matches. In other
words, the subform displays any plants where the
CatalogName field matches the value in the main
form’s Name field. This might or might not be what
you want. Just remember, you can always dump
the form and use one of the other AutoForm wiz-
ards. Or, you can use the Form Wizard to exercise a
bit more control over the results. Close the form
before continuing. You’ll learn more about building
and customizing subforms in Chapter 13.

The Form Wizard
The Form Wizard creates the form for you but
allows you to set limits to the data the form will
display. You start the wizard the same way you do
an AutoForm wizard, except in the New Form dia-
log box, you select Form Wizard.

Now, let’s look at the options the Form Wizard
enables you to select as you create a new form.
Specifically, we’ll base a form on both the Types
and Plants tables. To do so, follow these steps:

1. Display the New Form dialog box by selecting Form from the New Object
button’s drop-down list or selecting Form from the Insert menu.

2. Select Form Wizard in the New Form dialog box.

3. Select Types from the drop-down control, and click OK.

4. The Available Fields list displays all the fields in the Types table. You’ll move
the fields you want to add to the form to the Selected Fields list by clicking
one of the arrow buttons the same way that you did with the Simple Query
Wizard in Chapter 7, “Retrieving Data with Queries.” The single arrow button
(>) moves one field at a time; the double arrow button (>>) moves all the
fields to the Selected Fields list. For this example, click the double arrow but-
ton to move all the fields to the Selected Fields list, as shown in Figure 8.6.

5. Now, let’s add some data from the Plants table. To do so, simply select Table:
Plants from the Tables/Queries drop-down list, which updates the Available
Fields list accordingly. Move the CommonName, LatinName, and
CatalogName fields to the Selected Fields list, as shown in Figure 8.7. Click
Next to continue.
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If you used the New
Object list’s version of the

AutoForm to create a form based
on the Plants table, it will not cre-
ate a subform, even though that
table has two relationships: one
with Catalogs and one with Types.
The wizard creates a subform when
the form you specify contains the
primary key value in a relationship.
The primary key in Plants is not
related to any other table—only the
Plants table’s foreign key values are
related to the other tables.
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6. Because you selected fields from more than one table, the wizard offers three
ways to display the related data. The wizard defaults to displaying the plant
records data in a subform and shows you a schematic picture of this option.

7. To see the other options, select the By Plants item in the list to the left, and
the wizard updates the sample form to the right accordingly. Notice that the
wizard also selects the Single Form option at the bottom of the dialog box.
Reselect the By Types item and click the Linked Forms option to view that
sample, which creates two linked forms. Be sure to reselect the Form with
SubForm(s) option before clicking Next to continue.

8. The next window enables you to choose the type of form you want: Tabular,
Datasheet, PivotTable, or PivotChart. Select Tabular, and click Next.
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FIGURE 8.6

Include both

fields from the

Types table.

Select a table or query

Move all fields

FIGURE 8.7

Include three

fields from the

Plants table.

Move one field at a time

Select the Plants table
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9. At this point, you can choose from any number of autoformats. An autofor-
mat lets you set the default colors and fonts for a form, among other things.
The wizard defaults to Standard, and that’s the format we’ll keep. Click Next
without changing this option. (You can learn more about autoformats in
Chapter 13.)

10. In the last window, rename the form and the subform TypesMain and
PlantsSub, respectively, as shown in Figure 8.8. You can also select to open the
form in form view so you can start entering data or in design view, where you
can modify the form’s design. (It’s common to tweak the product of a wizard.)
Open the form in form view by clicking Finish without changing the 
wizard’s selection.
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FIGURE 8.8

Name the two

forms (the main

form and sub-

form) and click

Finish.

The new form, shown in Figure 8.9 lists the type possibilities in the main form. The
subform displays the plant records for the type that’s current in the main form.

You’ll see that forms contain the same navigation buttons that you’re already famil-
iar with from datasheets. If you click the Next Record navigation button on the sub-
form (refer to Figure 8.9), the selection arrow in the left margin of the subform
advances one row, from Black-Eyed Susan to Cosmos. If you click the Next Record
navigation button on the main form to display a new type, the subform updates the
plant records accordingly. As you can see in Figure 8.10, type 2 (edible plants) cur-
rently has no related plant records. Close the form.
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FIGURE 8.9

The wizard has

produced a form

that displays the

plant names in

a subform.

Next record 
for subform

SubformMain form

Next record for 
main form

FIGURE 8.10

As yet, no edible

plants exist in

the database.

Creating a Form in Design View
You don’t need a wizard to create a form. Although the wizards do a good job, some-
times simply starting from scratch can be more efficient. When this is the case, open
a blank form in design view and start adding controls. To open a blank form in
design view, do the following:

1. Select Form from the Insert menu. Or, select Form from the New Object but-
ton’s drop-down list.

2. Design view is the default option in the resulting New Form dialog box, and
this is the option you want.

3. If you didn’t specify a table or query in step 1, select the appropriate table or
query now in the drop-down control.

4. Click OK to open a blank form in design view, as shown in Figure 8.11.

In Chapter 13, you’ll learn how to customize a form in design view by adding and
formatting controls and formatting the form itself. For now, just close the form with-
out saving it.
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Quick Error Detection with Error-Checking
Access 2003’s new error-checking smart tag warns you when you make common
form and report errors. (You can learn more about smart tags in Chapter 5,
“Building Your First Tables.”) If you’re familiar with
Excel 2002, you may be familiar with the feature
already, as Excel 2002 uses a similar smart tag to
point out spreadsheet errors. In this section, you’ll
make a mistake on purpose, just so you can experi-
ence the error-checking smart tag:

1. Open the Plants form in design view by
clicking the Forms shortcut in the Database
window, selecting Plants, and then clicking
Design in the Database Window toolbar.

2. In form view, double-click the
CommonName control to display that 
control’s properties in the Properties window.

3. Click the All Tab. The Control Source prop-
erty is currently CommonName because this
control is bound to the CommonName field
in the Plants table. Change that setting to
anything other than the name of a valid
field in the Plants table. As you can see in
Figure 8.12, we entered Test (there is no field
named Test).
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Although you’ll be
working more closely with

forms in Chapter 13, now is the
time to learn about this built-in
smart tag. As you work through
our examples in each chapter, 
you may launch one of these
smart tags and you’ll need to
know what it is and how to get
rid of it.

FIGURE 8.11

A blank form in

design view.
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Entering Data Through Forms
Now that you know how to create a form, let’s learn how to use it to enter and mod-
ify data. First, open the Plants form by clicking the Forms shortcut on the Object
bar and double-clicking Plants in the Database window. You’ll see that some of the
user interface for a form resembles the user interface you’ve already seen for tables
and queries, but there are new things here as well. The form shown in Figure 8.13
can tell you a lot, such as

■ The title bar displays the form’s name and purpose.

■ The record selector points out the active record. The sample form displays
only one record at a time, but that isn’t always the case. For example, in the
subform in Figure 8.9 you can see more than one record at a time. On this
form, the current record is for Black-eyed Susan.

■ The navigation bar displays the number of records and enables you to browse
through those records. The current record is the first record of seven.
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FIGURE 8.12

Enter a field

name that

doesn’t exist to

display the error

smart tag.

Enter an invalid
Control Source property

Click the smart tag icon

4. When you press Enter or try to move to another field, Access displays a smart
tag icon next to the problem control in the form. Clicking the icon displays a
list of possible errors and solutions, as shown in Figure 8.12. In this case, the
error is an invalid Control Source property. Among other actions, you can
select Edit the Control’s Control Source Property to automatically select and
highlight the Control Source property in the Properties window, or you can
ignore the error. For now, just close the form without saving the change.
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Navigating Fields and Records
In a table or query, you might refer to a particular column of data as a field. Forms
use controls to display data. Right now the form displays the records you entered
directly into the Plants table in earlier chapters.

When you open a form, Access selects the first control in the form. For instance, when
you open the Plants form, Access selects the CommonName control—you can tell
because the actual entry is highlighted. To move from one control to the next, simply
press the Tab key. Sometimes the Enter key performs the same function, but not
always, so the preferred method is the Tab key. For example, press the Tab key once
to select the LatinName control. Then, press Enter to select the Notes control. While
in the Notes memo field, pressing Enter simply moves the insertion point to the next
line in the memo field. To move to the next control, the Picture control, you must
press the Tab key. Table 8.1 lists helpful keystroke combinations for navigating a
form, and Table 8.2 contains combinations for navigating in a form with a subform.

TABLE 8.1 Keyboard Shortcuts for Navigating Controls
Press Result

F5+number Selects a specific record

Tab Moves to the next field

Shift+Tab Moves to the previous field

End Moves to the last field in the current record
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FIGURE 8.13

A basic form can

give you a lot of

information

about your data.

Navigation Bar

Title Bar

First Record

New Record

Total Number of Records

Last Record

Previous Record
Next Record

Current Record Number

Record Selector
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Ctrl+End Moves to the last field in the last record

Home Moves to the first field in the current record

Ctrl+Home Moves to the first field in the first record

Ctrl+Page Down Moves to the current field in the next record

Ctrl+Page Up Moves to the current field in the previous record

TABLE 8.2 Keyboard Shortcuts for Navigating Between a Main Form
and a Subform

Press Result

Tab Enters the subform from the field that precedes the subform in the 
main form

Shift+Tab Returns to the subform from the field following the subform in the 
main form

Ctrl+Tab Exits the subform and moves to the next field in the main form or next
record

Ctrl+Shift+Tab Exits the subform and moves to the field that precedes the subform in the
main form or previous record

Did you notice that the Notes control displayed a scrollbar when you selected it?
That’s because that control is based on a memo data type (at the table level). We
chose that data type because it can store a lot more text than the normal text data
type.

When you’re ready to see the next record, simply click the Next Record button on
the navigation bar. Or, keep pressing the Tab key until the last control is selected,
which in this case is the CatalogName control. Then, press Tab one more time.
When you do, Access displays the next record.

Entering data is simple: Just select a field and type the data. When you’re done,
press Tab or Enter, as the case may be. For example, with the Calendula record cur-
rent, select the Notes control and enter the following text: This plant loves cooler
weather and full sun but will tolerate a hot spot if you keep well watered. You can

expect lots of blooms well into fall. When you’re done, press Tab to select the
Picture control. Right now, none of your records are displaying pictures, but you can
fix that by following these steps:

1. With the Picture control selected, select Object from the Insert menu. (You
can also right-click the Picture control and select Insert Object from the
resulting submenu.)
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Press Result
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2. Click the Create from File option to the left of the dialog box.

3. Click the Browse button to locate the picture file you want to display. We
recommend you store pictures in the same folder with your database. When
you find the correct graphics file, double-click it. Or, select it and click OK.
Access will display the name of the graphic file in the File control, as shown
in Figure 8.14. Click the Link option only if you plan to modify the graphic
file. In this case, you won’t be modifying the pictures, so don’t select it.
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FIGURE 8.14

Browse to the

graphic file that

you want to dis-

play with the

current record.

4. Click OK.

5. The control will probably display a small version of the file in the upper-left
corner, as shown in Figure 8.15. If this happens, click the Properties button
on the Form view toolbar.

FIGURE 8.15

Sometimes, the

control displays

a small version

of the file.

6. In the Properties list for the Bound Object Frame, open the Size Mode prop-
erties drop-down list and select Stretch, as shown in Figure 8.16. The default
is Clip.
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7. Close the Properties window, and the control
should display a full view of the file. You’ll
learn more about control properties in
Chapter 13.

8. Repeats steps 1–4 to embed pictures of each
plant.

9. When you’re done, close the form and save
it when prompted. You’re not saving the
data you just entered; Access automatically
saves the new picture data. Remember dur-
ing step 6 when you changed the Size Mode
property? That’s what you’re saving now.

You might be curious about how a picture looks in
datasheet view, so open the Plants table after you
enter a few (or all) of the picture files. Figure 8.17
shows the Plants table after inserting a picture for
each record. Each picture entry is a bitmap image.
A table doesn’t actually display a picture the same
way a form or report does.

Of course, you won’t always be adding new data
via forms. Sometimes you’ll delete data or replace
an entry with something new. Fortunately, it’s all
very easy in a form. When you select a control, the
form automatically highlights the entry. At this
point, you can do any of the following:

■ Press Delete to delete the entry.

■ Start typing to replace the entry.
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FIGURE 8.16

Select the Stretch

Size Mode prop-

erty.

Did you notice that the
CommonName label to the

left of that control isn’t completely
visible? (Depending on your sys-
tem’s display properties, this might
not occur in your form, so don’t
worry if it doesn’t.) That’s just one
of the small annoyances you’ll run
into when using a wizard; it simply
didn’t allow enough room. In
Chapter 13, you’ll learn how to
modify controls that don’t behave
the way you want them to.

Graphic files vary greatly, and
there’s no way to guarantee the
quality of each file from record to
record. You can improve a picture,
but that’s a bit beyond the scope
of this chapter.
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When you’re editing records, the record selector you saw earlier changes to the small
pencil icon, just as it does on a datasheet (refer to Figure 8.15). You can demonstrate
this in the Plants form by selecting the LatinName control and pressing the Delete key.
If you try this yourself, press Esc to cancel the delete task so that you don’t lose data.

Adding and Deleting Records
In the previous section, you learned how to enter and delete new data. Occasionally,
you’ll need to add or delete an entire record. You can add records in four ways:

■ Click the New Record button on the form’s navigation bar, as mentioned ear-
lier.

■ Click the New Record button on the form view toolbar.

■ Select New Record from the Insert menu.

■ Press Ctrl++.

All the previous methods display a blank record. Let’s walk through the process of
creating a new record. Do the following:

1. Use one of the methods mentioned above to display a new record. Notice that
the record number control in the navigation bar displays the number 8—you
will be entering the eighth record. As soon as you begin to enter data, Access
updates the record selector to display the editing symbol (the pencil icon).

2. With the CommonName control selected, enter French Lavender and press Tab.

3. Enter Lavandula stoechas and press Tab three times.

4. Open the TypeID control’s drop-down list and select Decorative; then 
press Tab.

5. Enter Richters. 

6. Save the record by selecting Save Record from the Records menu, pressing
Shift+Enter, or simply moving to another record. Figure 8.18 shows the new
record.
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FIGURE 8.17

Graphic files

appear as text in

datasheet view.

■ Use the mouse to precisely position the insertion point so you can change one
or just a few characters in the existing entry.
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Deleting a record is even easier. After selecting
the appropriate record in your form, use one of
the following methods to delete that record:

■ Click the Record Selector and then press
the Delete key.

■ Select Delete Record from the Edit menu.

■ Click the Delete Record button on the
form view toolbar.

After you attempt to delete the record, Access dis-
plays a confirmation message. You’d click Yes to
delete the record, or you’d click No to cancel the
delete task. Right now, click No because you don’t
want to delete the record.

Finding Information with Forms
In Chapter 6, you learned how to sort and limit
the results of a query. You can also sort and limit
data in a form; we’ll show you how to do so in
this section.

Sorting Records in a Form
Do you remember setting the sort order for a
query in Chapter 7? In the design grid, you selected
Ascending, Descending, or None in a field’s sort cell. When you ran the query,
Access presented the records in the appropriate order. Sorting in a form is very simi-
lar, but there’s no sort cell.

Let’s look at a quick example using your Plants form. The form sorts the records by
the CommonName field because that field is the primary key for the Plants table.
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FIGURE 8.18

You haven’t

entered a picture

of your new

plant yet.

tip
If you change your mind

while you’re entering a
record, you can press Esc
twice to delete the record
before it’s saved.

You won’t always want to
view existing records while enter-
ing new ones. When that’s the
case, select Data Entry from the
Records menu and Access will
remove existing data from the form
and update the record numbers in
the navigation bar. To return the
records, select Remove Filter/Sort
from the Records menu.

Not all forms allow you to enter
new records. If the New Record
button is disabled, you’ll know the
form is just for browsing and edit-
ing existing data.
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When you assign a primary key, Access automatically 
defines an index for that field and an index sorts 
the data according to the field’s data type. For
instance, if the field is text, the data sorts 
alphabetically.

Let’s temporarily rearrange your plant records by
sorting them by their LatinName entries. To do
so, follow these steps:

1. Select the LatinName control for any
record.

2. Click the Sort Ascending button on the
Form view toolbar. Figure 8.19 shows the
results. As you can see by the navigation
controls, the first record is no longer Black-
eyed Susan; instead it is Yarrow. If you browse the records, you’ll find them in 
alphabetical order according to the LatinName entries.
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Don’t assign a primary
key just to sort data.
From our discussion in
Chapter 4, “Planning a
Database,” you might
remember that a primary key’s func-
tion is to uniquely identify a
record—sorting is just a by-product.

caution

FIGURE 8.19

Sorting the

records by the

LatinName

entries.

Sort tasks are temporary, unless you save the
sorted form. In that case, Access remembers the
new sort order the next time you open the form.
To remove a temporary sort you’ve saved, select
Remove Filter/Sort from the Records menu.

Using Filter by Selection
The Filter by Selection feature in forms is similar
to the table feature you learned about in
Chapter 5. You simply select a control and apply
the filter—Access does the rest. The main difference
is that the Filter by Selection feature limits the records it displays by eliminating all
records that don’t match the entry in the current control.

tip
A quick sort can filter

records. It doesn’t limit the
records, but it does group
the records by the sort field.
You can then browse a par-

ticular group without first
applying a more complex

filter or query.
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Now, let’s suppose you want to browse only the decorative plants. To do so, follow
these steps:

1. Select the TypeID control in the first record (or any record that displays
Decorative in the TypeID control).

2. Select Records, Filter, Filter by Selection, or click the Filter by
Selection button on the Form view toolbar. Figure 8.20 shows the results of
the filter, and five records match the selected control (Decorative).
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FIGURE 8.20

Use the Filter by

Selection feature

to limit the

records in your

form.

Notice that the navigation bar has updated the number of records. Specifically,
there’s a total of five records instead of eight. In addition, the toolbar now displays
the text (Filtered). That way, you know you’re looking at an incomplete set of
records. To remove the record, click the Remove Filter button or select Remove
Filter/Sort from the Records menu. Do that now to return your form to normal.

Using Filter by Form
The Filter by Form feature is similar to the Filter by Selection feature but more com-
plex. Using this feature, you can specify the actual value that Access will attempt to
match, instead of relying on existing data. You can also refer to more than one 
control.

Let’s illustrate this filtering feature by finding the medicinal plants you purchased
from Wildseed Farms. Do the following:

1. Select Records, Filter, Filter by Form, or click the Filter by Form button
on the Form view toolbar.

2. Access displays the filtering form shown in Figure 8.21. Access remembers the
last filter, which is why an entry exists in the TypeID control—that’s a left
over from the Filter by Selection exercise in the last section. You should clear
any existing filters before you apply a filter by clicking the Clear Grid but-
ton on the Filter/Sort toolbar.
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3. Select Medicinal from the TypeID control.

4. Select the CatalogName control, and Access
displays a drop-down arrow to the right.
Click it to display the possible entries by
which you could filter. Then select
Wildseed Farms.

5. Click the Apply Filter tool on the
Filter/Sort toolbar to display the filtered set
of records. The form shows only medicinal
plants from Wildseed Farms.

The filtered set contains only one record—Purple
Coneflower. To remove the filter, click the Remove
Filter button on the Form view toolbar or select
Remove Filter/Sort from the Records menu.
Remove the filter now.

Using the Find Dialog Box
So far, you’ve sorted and filtered. You can also search for a particular value in a
record using the Find dialog box. This feature is similar to the Filter by Selection fea-
ture, but it doesn’t filter the results and all the records are still available to you. Let’s
use this feature to find the record for purple coneflower. Follow these steps:

1. From any record other than the record for Purple Coneflower, select the
CommonName control. Then select Find from the Edit menu or press
Ctrl+F.
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FIGURE 8.21

Using the Filter

by Form feature

to find all your

medicinal plants

purchased from

Wildseed Farms.

You might have noticed
that the Remove Filter and

Apply Filter buttons use the same
icon. Don’t let that confuse you
because you can’t make a mistake
by clicking the button at the
wrong time. The buttons perform
the appropriate task.
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The record you see in Figure 8.22 might not be the
only record that matches your entry. In this case it is,
but if it weren’t, you’d click Find Next again to see
the next matching entry and continue doing so
until you found the record you were searching for.
Close the Find and Replace dialog box when you’re
done searching.

The Find and Replace feature lets you qualify a
search by specifying the field you’re searching,
specifying just how much of the entry you want to
consider, determining the direction of the search,
matching the letter case, and considering any for-
matting.
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FIGURE 8.22

Access displays

the first match-

ing record when

you click the

Find Next 

button.

Throughout this chap-
ter, all the forms have been

based on tables, but don’t forget
that you can also base a form on a
query. Doing so provides a perma-
nent means of filtering and sorting
the form’s data. Eventually, you
might find that you seldom base a
form on a table and that you rely a
great deal on queries to provide
the data for your forms.

2. Enter Purple Coneflower as the data to find.

3. Click Find Next, and Access displays the record shown in Figure 8.22. You
might need to move the Find and Replace dialog box to see the results of the
search.
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The Absolute Minimum
Storing data may be the purpose of a database, but it’s your job to enter and main-
tain that data. Forms are the best way to enter new data, modify existing data, and
even delete unwanted data. In this chapter, you learned to do the following:

■ Create forms using wizards

■ Navigate forms and enter new data

■ Modify existing data

■ Sort, filter, and search records
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